Preface vii
  1. Document Conventions ................................................................. vii
    1.1. Typographic Conventions ...................................................... vii
    1.2. Pull-quote Conventions ......................................................... viii
    1.3. Notes and Warnings ............................................................. ix
  2. We Need Feedback! ................................................................... ix

Introduction xi
  1. About Fedora Core ................................................................... xi
  2. About this Manual .................................................................... xi
  3. Acknowledgements .................................................................... xi

1. Background 1

2. Understanding i386 and Other Computer Architectures 3

3. Before You Begin 5
  3.1. Storage .................................................................................. 5
  3.2. Networking ........................................................................... 5
  3.3. Installing from a Server or Web Site ....................................... 5
  3.4. Installing Fedora Core on a Managed Network ...................... 6

4. Preparing Media 7
  4.1. Preparing CD or DVD Media .................................................. 7
  4.2. Preparing USB Boot Media .................................................... 8

5. Beginning the Installation 11
  5.1. Booting from CD, DVD, or USB Media ................................... 11
  5.2. Testing CD and DVD Media .................................................. 13
  5.3. Booting from the Network using PXE ................................. 15

6. Identifying Your Locale 17
  6.1. Language Selection ............................................................. 17
  6.2. Keyboard Configuration ....................................................... 17

7. Installation Methods 19
  7.1. Default Installation Method .................................................... 19
  7.2. Alternative Installation Methods ........................................... 19
  7.3. Installation from a Hard Drive .............................................. 20
  7.4. Installation TCP/IP Configuration ......................................... 21
  7.5. NFS Installation Setup .......................................................... 23
  7.6. FTP Installation Setup .......................................................... 23
  7.7. HTTP Installation Setup ....................................................... 25

8. Welcome Dialog 27

9. Upgrading an Existing System 29
  9.1. Upgrade Examine ................................................................. 29
  9.2. Upgrading Boot Loader Configuration ................................. 30

10. Disk Partitioning 31
  10.1. General Information on Partitions ........................................ 32
      10.1.1. Partition Types ............................................................ 34
      10.1.2. Understanding LVM ..................................................... 34
      10.1.3. Creating a /home Partition ......................................... 34
  10.2. Disk Druid ................................................................. 34

11. Boot Loader 39
# Installation Guide

11.1. Keeping Your Existing Boot Loader Settings ................................................................. 39
11.2. Booting Additional Operating Systems ........................................................................ 40
11.3. Setting a Boot Loader Password .................................................................................. 41
   11.3.1. Forgotten GRUB Password .................................................................................. 42
11.4. Advanced Boot Loader Options .................................................................................. 42

12. Network Configuration .................................................................................................. 45
   12.1. Network Devices ...................................................................................................... 45
   12.2. Computer Hostname .............................................................................................. 46
   12.3. Miscellaneous Settings ......................................................................................... 46

13. Time Zone Selection ..................................................................................................... 47
   13.1. Selecting a Time Zone ......................................................................................... 47
   13.2. Universal Co-ordinated Time (UTC) ................................................................. 47

14. Set the Root Password ................................................................................................. 49

15. Software Selection ....................................................................................................... 51
   15.1. Installing from Additional Repositories .................................................................... 51
   15.2. Customizing the Software Selection ........................................................................ 54
       15.2.1. Changing Your Mind ...................................................................................... 55
       15.2.2. Additional Language Support ........................................................................ 55
       15.2.3. Core Network Services .................................................................................. 55

16. About to Install ............................................................................................................. 57

17. Installing Packages ...................................................................................................... 59

18. First Boot ....................................................................................................................... 61
   18.1. License Agreement ............................................................................................... 61
   18.2. Firewall ................................................................................................................. 62
   18.3. SELinux ............................................................................................................... 64
   18.4. Date and Time ....................................................................................................... 65
   18.5. System User ......................................................................................................... 67
   18.6. Sound Card .......................................................................................................... 68

19. Your Next Steps ............................................................................................................. 71
   19.1. Updating Your System .......................................................................................... 71
   19.2. Subscribing to Fedora Core Announcements and News .................................... 72
   19.3. Finding Documentation and Support .................................................................. 72
   19.4. Joining the Fedora Core Community ................................................................... 72

A. Boot Options ................................................................................................................ 75
   A.1. Configuring the Installation System at the boot: Prompt ........................................ 75
       A.1.1. Specifying the Language ............................................................................... 75
       A.1.2. Configuring the Interface .............................................................................. 75
       A.1.3. Specifying the Installation Method ............................................................... 76
       A.1.4. Manually Configuring the Network Settings .................................................. 76
   A.2. Enabling Remote Access to the Installation System ............................................. 77
       A.2.1. Enabling Remote Access with VNC ............................................................. 77
       A.2.2. Connecting the Installation System to a VNC Listener .................................. 77
       A.2.3. Enabling Remote Access with Telnet ............................................................ 78
   A.3. Logging to a Remote System During the Installation ............................................ 78
       A.3.1. Configuring a Log Server .............................................................................. 79
   A.4. Automating the Installation with Kickstart ......................................................... 79
   A.5. Enhancing Hardware Support ............................................................................... 80
A.5.1. Adding Hardware Support with Driver Disks ...................................................... 81
A.5.2. Overriding Automatic Hardware Detection ......................................................... 82
A.6. Using the Maintenance Boot Modes ........................................................................ 82
  A.6.1. Loading the Memory (RAM) Testing Mode ..................................................... 82
  A.6.2. Booting Your Computer with the Rescue Mode ............................................... 83

B. Other Technical Documentation 85

Index 87
Preface

1. Document Conventions

This manual uses several conventions to highlight certain words and phrases and draw attention to specific pieces of information.

In PDF and paper editions, this manual uses typefaces drawn from the Liberation Fonts\(^1\) set. The Liberation Fonts set is also used in HTML editions if the set is installed on your system. If not, alternative but equivalent typefaces are displayed. Note: Red Hat Enterprise Linux 5 and later includes the Liberation Fonts set by default.

1.1. Typographic Conventions

Four typographic conventions are used to call attention to specific words and phrases. These conventions, and the circumstances they apply to, are as follows.

**Mono-spaced Bold**

Used to highlight system input, including shell commands, file names and paths. Also used to highlight keycaps and key combinations. For example:

To see the contents of the file *my_next_bestselling_novel* in your current working directory, enter the `cat my_next_bestselling_novel` command at the shell prompt and press **Enter** to execute the command.

The above includes a file name, a shell command and a keycap, all presented in mono-spaced bold and all distinguishable thanks to context.

Key combinations can be distinguished from keycaps by the hyphen connecting each part of a key combination. For example:

Press **Enter** to execute the command.

Press **Ctrl**+**Alt**+**F1** to switch to the first virtual terminal. Press **Ctrl**+**Alt**+**F7** to return to your X-Windows session.

The first paragraph highlights the particular keycap to press. The second highlights two key combinations (each a set of three keycaps with each set pressed simultaneously).

If source code is discussed, class names, methods, functions, variable names and returned values mentioned within a paragraph will be presented as above, in **mono-spaced bold**. For example:

File-related classes include **filesystem** for file systems, **file** for files, and **dir** for directories. Each class has its own associated set of permissions.

**Proportional Bold**

This denotes words or phrases encountered on a system, including application names; dialog box text; labeled buttons; check-box and radio button labels; menu titles and sub-menu titles. For example:

\(^1\) https://fedorahosted.org/liberation-fonts/
Choose System $\rightarrow$ Preferences $\rightarrow$ Mouse from the main menu bar to launch Mouse Preferences. In the Buttons tab, click the Left-handed mouse check box and click Close to switch the primary mouse button from the left to the right (making the mouse suitable for use in the left hand).

To insert a special character into a gedit file, choose Applications $\rightarrow$ Accessories $\rightarrow$ Character Map from the main menu bar. Next, choose Search $\rightarrow$ Find… from the Character Map menu bar, type the name of the character in the Search field and click Next. The character you sought will be highlighted in the Character Table. Double-click this highlighted character to place it in the Text to copy field and then click the Copy button. Now switch back to your document and choose Edit $\rightarrow$ Paste from the gedit menu bar.

The above text includes application names; system-wide menu names and items; application-specific menu names; and buttons and text found within a GUI interface, all presented in proportional bold and all distinguishable by context.

**Mono-spaced Bold Italic or Proportional Bold Italic**

Whether mono-spaced bold or proportional bold, the addition of italics indicates replaceable or variable text. Italics denotes text you do not input literally or displayed text that changes depending on circumstance. For example:

To connect to a remote machine using ssh, type `ssh username@domain.name` at a shell prompt. If the remote machine is example.com and your username on that machine is john, type `ssh john@example.com`.

The `mount -o remount file-system` command remounts the named file system. For example, to remount the /home file system, the command is `mount -o remount /home`.

To see the version of a currently installed package, use the `rpm -q package` command. It will return a result as follows: `package-version-release`.

Note the words in bold italics above — username, domain.name, file-system, package, version and release. Each word is a placeholder, either for text you enter when issuing a command or for text displayed by the system.

Aside from standard usage for presenting the title of a work, italics denotes the first use of a new and important term. For example:

Publican is a DocBook publishing system.

### 1.2. Pull-quote Conventions

Terminal output and source code listings are set off visually from the surrounding text.

Output sent to a terminal is set in **mono-spaced roman** and presented thus:

```
books   Desktop   documentation  drafts  mss   photos  stuff  svn
books_tests  Desktop1  downloads  images  notes  scripts  svgs
```
Source-code listings are also set in **mono-spaced** *roman* but add syntax highlighting as follows:

```java
package org.jboss.book.jca.ex1;
import javax.naming.InitialContext;
public class ExClient {
    public static void main(String args[]) throws Exception {
        InitialContext iniCtx = new InitialContext();
        Object         ref    = iniCtx.lookup("EchoBean");
        EchoHome       home   = (EchoHome) ref;
        Echo           echo   = home.create();
        System.out.println("Created Echo");
        System.out.println("Echo.echo('Hello') = " + echo.echo("Hello"));
    }
}
```

### 1.3. Notes and Warnings

Finally, we use three visual styles to draw attention to information that might otherwise be overlooked.

**Note**

Notes are tips, shortcuts or alternative approaches to the task at hand. Ignoring a note should have no negative consequences, but you might miss out on a trick that makes your life easier.

**Important**

Important boxes detail things that are easily missed: configuration changes that only apply to the current session, or services that need restarting before an update will apply. Ignoring a box labeled 'Important' won't cause data loss but may cause irritation and frustration.

**Warning**

Warnings should not be ignored. Ignoring warnings will most likely cause data loss.

### 2. We Need Feedback!

If you find a typographical error in this manual, or if you have thought of a way to make this manual better, we would love to hear from you! Please submit a report in Bugzilla: [http://bugzilla.redhat.com/bugzilla/](http://bugzilla.redhat.com/bugzilla/) against the product **Fedora Documentation**.

When submitting a bug report, be sure to mention the manual's identifier: *install-guide*
If you have a suggestion for improving the documentation, try to be as specific as possible when describing it. If you have found an error, please include the section number and some of the surrounding text so we can find it easily.
Introduction

1. About Fedora Core
Fedora Core is a complete desktop and server operating system created entirely with open source software.

Fedora Core Lifecycle
Fedora Core is a rapidly evolving system which follows the latest technical developments. Fedora Core may not be appropriate for use in business-critical applications in your organization.

For complete access to information about Fedora Core, refer to the official project wiki at http://fedoraproject.org/ and Chapter 19, Your Next Steps.

2. About this Manual
This manual helps you install Fedora Core on desktops, laptops and servers. The installation system is flexible enough to use even if you have no previous knowledge of Linux or computer networks. If you select default options, Fedora Core provides a complete desktop operating system, including productivity applications, Internet utilities, and desktop tools.

This document does not detail all of the features of the installation system.

3. Acknowledgements
Many useful comments and suggestions were provided by Rahul Sundaram and the Anaconda team. David Neimi and Debra Deutsch contributed additional information on boot loader and RAID configurations. The sections on LVM benefited from the contributions of Bob McKay.
Background

The Fedora Project, which produces and maintains Fedora Core, is a collaboration between Red Hat, Inc. and the free and open source software (FOSS) community. The Fedora Project also provides Fedora Extras, additional software packaged for installation on a Fedora Core system.

Understanding i386 and Other Computer Architectures

The Fedora Project provides distributions of Fedora Core for several different types of computer systems. Each distribution of Fedora Core is built for computers based on a specific architecture. The architecture describes the processor on which the computer is built. Most computers come with identifying marks and literature describing the processor inside the computer. Refer to your computer’s marks or literature and find its architecture in the list below:

i386
- Intel x86-compatible processors, including Intel Pentium and Pentium-MMX, Pentium Pro, Pentium-II, Pentium-III, Celeron, Pentium 4, Xeon, Core Duo, and Centrino/Centrino Duo; VIA C3/C3-m and Eden/Eden-N; and AMD Athlon, AthlonXP, Duron, AthlonMP, Sempron, and Turion

ppc
- PowerPC processors, such as those found in Apple Power Macintosh, G3, G4, and G5, and IBM pSeries systems

x86_64
- 64-bit AMD processors such as Athlon64/FX/X2, Turion64, Opteron; and Intel 64-bit processors such as EM64T
Before You Begin

Before you install Fedora Core, you need access to:

• boot or installation media (refer to Chapter 4, Preparing Media for more information)
• information about your network configuration
• a copy of this Installation Guide and the Release Notes for this version of Fedora Core

The Release Notes specify the hardware requirements for Fedora Core 6. They also provide advice on any known problems with particular hardware and software configurations.


3.1. Storage

A Fedora Core system requires a minimum of 700 MB storage for a command-line system. A desktop system with the default applications requires at least 3 GB of storage. You may install multiple copies of Fedora Core on the same computer.

Configure any RAID functions provided by the mainboard of your computer, or attached controller cards, before you begin the installation process. Fedora Core can automatically detect many RAID devices and use any storage they provide.

3.2. Networking

By default, Fedora Core systems attempt to discover correct connection settings for the attached network using Dynamic Host Configuration Protocol, or DHCP. Your network may include a DHCP provider which delivers settings to other systems on demand. The DHCP provider may be a router or wireless access point for the network, or a server.

In some circumstances you may need to provide information about your network during the installation process. Refer to Section 3.3, “Installing from a Server or Web Site” and Section 3.4, “Installing Fedora Core on a Managed Network” for more information.

Modem Configuration

The installation system for Fedora Core does not configure modems. If your computer has a modem, configure the dialing settings after you complete the installation and reboot.

3.3. Installing from a Server or Web Site

You may install Fedora Core using a mirror, a Web site or network server that provide a copy of the necessary files. To use a mirror, you need to know:

• the name of the server
• the network protocol used for installation (FTP, HTTP, or NFS)
• the path to the installation files on the server

You may install Fedora Core from your own private mirror, or use one of the public mirrors maintained by members of the community. To ensure that the connection is as fast and reliable as possible, use a server that is close to your own geographical location.

The Fedora Project maintains a list of HTTP and FTP public mirrors, sorted by region, at http://fedora.redhat.com/download/mirrors.html. To determine the complete directory path for the installation files, add /6/architecture/os/ to the path shown on the web page. If your computer uses the ppc architecture, for instance, add /6/ppc/os/ to the path shown.

Building Your Own Mirror
Refer to http://fedora.redhat.com/docs/mirror/ for information on how to create your own Fedora Core mirror for either public or private use.

To use a mirror, boot your computer with Fedora Core boot media, and follow the instructions in Chapter 7, Installation Methods. Refer to Chapter 4, Preparing Media for more information on creating the boot media.

Using the Installation Discs
If you boot your computer with either an installation DVD, or the first installation CD, enter linux askmethod at the boot: prompt to access the server installation options.

If your network includes a server, you may also use PXE (Pre-boot eXecution Environment) to boot your computer. PXE (also referred to as netboot) is a standard that enables PCs to use files on a server as a boot device. Fedora Core includes utilities that allow it to function as a PXE server for other computers. You can use this option to install Fedora Core on a PXE-enabled computer entirely over the network connection, using no physical media at all.

3.4. Installing Fedora Core on a Managed Network
Some corporate networks include a directory service that manages user accounts for the organization. Fedora Core systems can join a Kerberos, NIS, Hesiod, or Microsoft® Windows® domain as part of the installation process. Fedora Core can also use LDAP directories.

Consult Network Administrators
Always consult the administrators before you install a Fedora Core system on an existing network owned by someone besides yourself. They can provide correct network and authentication settings, and guidance on specific organizational policies and requirements.
Preparing Media

To install Fedora Core from discs, you need five installation CDs, or the installation DVD. There are separate disc sets for each supported architecture.

For instructions to download and prepare this CD or DVD installation media, refer to http://fedoraproject.org/wiki/Distribution/Download. If you already have the full set of Fedora Core installation media, skip to Section 5.1, “Booting from CD, DVD, or USB Media”.

Architecture-Specific Distributions

To install Fedora Core, you must use the boot and installation media that is particular to your architecture. Refer to Chapter 2, Understanding i386 and Other Computer Architectures for information on hardware architectures and how to determine the right one for your computer.

You may use the first CD or DVD installation disc from the complete Fedora Core distribution to boot your computer. The Fedora Core distribution also includes image files for boot-only CD or DVD media and USB media. You can convert these files into bootable media using standard Linux utilities or third-party programs on other operating systems.

You may boot your computer with boot-only media, and load the installation system from another source to continue the process. The types of installation source for Fedora Core include:

- CD or DVD media installation discs
- hard drive, either attached by USB, or internal to the computer
- network installation server, using either HTTP, FTP, or NFS

You can use this facility to install Fedora Core on machines without using installation discs. For example, you may install Fedora Core on a laptop with no CD or DVD drive by booting the machine with a USB pen drive, and then using a hard drive as an installation source.

The supported boot media for Fedora Core include:

- CD or DVD media (either installation disc #1 or a special boot-only disc)
- USB media
- network interface (via PXE)

Installation from Diskettes

There is no option to either boot or install Fedora Core from diskettes.

4.1. Preparing CD or DVD Media

The images/boot.iso file on the first Fedora Core installation disc is a boot image designed for CD and DVD media. This file also appears on FTP and Web sites providing Fedora Core. You can also find this file on mirror sites in the Fedora Core distribution directory for your particular architecture.
The Fedora Core distribution is also downloadable as a set of CD-sized ISO image files or a single DVD-sized ISO image file. You can record these files to CD or DVD using a CD or DVD burning program on your current operating system:

Windows operating systems
Burn an ISO image to disc using your installed CD or DVD burning software. Most software has an option labeled **Burn image file to disc** or **Make disc from ISO image**. If your software offers a choice of image formats, choose "ISO image" as the file type. If several ISO formats are offered, choose the closest match to "Mode 1, 2048-byte blocks."

Apple Mac OS X
Open the **Disk Utility** application, found in the `/Applications/Utilities` folder. Select **File** → **Open Disk Image** and select the ISO image. From the list of volumes, select the item representing the ISO image. Select **Burn** and follow the instructions.

Linux operating systems
If you are using a recent version of the GNOME desktop environment, right-click the ISO image file and choose **Write to disc**. If you are using a recent version of the KDE desktop environment, use **K3B** and select **Tools** → **Burn CD Image**, or **Tools** → **Burn DVD ISO Image** if appropriate. The following command line works for many other environments:

```
cdrecord --device=cdwriter-device -tao -eject image-file.iso
```

**System-Specific Instructions**
Unfortunately this guide cannot offer specific instructions for every possible combination of hardware and software. You can find more information at [http://fedoraproject.org/wiki/Docs/Drafts/BurningDiscs](http://fedoraproject.org/wiki/Docs/Drafts/BurningDiscs). Consult your operating system's documentation and online support services, and Section 19.3, "Finding Documentation and Support" for additional help if needed.

### 4.2. Preparing USB Boot Media

**Data Loss**
*This procedure destroys data on the media.* Back up any important information before you begin. Some models of USB media use additional partitions or software to provide functions such as encryption. This procedure may make it difficult or impossible to access these special areas on your boot media.

The **images/diskboot.img** file on the first Fedora Core installation disc is a boot image designed for USB media. This file also appears on FTP and Web sites providing Fedora Core.

Several software utilities are available for Windows and Linux that can write image files to a device. Linux includes the **dd** command for this purpose.

The **dd** utility requires you to specify the device file that corresponds to the physical media. The name of the device file matches the name assigned to the device by your system. All device files appear
Preparing USB Boot Media

in the directory /dev/. For example, /dev/sda denotes the first USB, SATA, or SCSI device that is attached to the system.

To learn the name that your system assigns to the media:

1. Open a terminal window. On a Fedora Core system, choose Applications → Accessories → Terminal to start a terminal.

2. Attach or insert the media.

3. In the terminal window, type the following command:

   dmesg

   Look for the items in the dmesg output that relate to the detection of a new SCSI device. Linux systems treat USB media as SCSI devices.

Using the Device Mapper

On Fedora Core 5 and later systems, it may be easier to find the right device name by examining the /dev/disk/ directory. Use the command ls -l /dev/disk/by-id/ to see the disk devices collated by model and device name.

4. Unmount the media. On a Fedora Core system, right-click the icon that corresponds to the media, and select Unmount Volume. Alternatively, enter this command in a terminal window:

   umount /dev/<device>

   Replace <device> with the name of the correct device file for the media.

To write an image file to boot media with dd on a current version of Fedora Core, carry out the following steps:

1. Locate the image file.

2. Attach or insert the media.

3. Your system may automatically detect and open the media. If that happens, close or unmount the media before continuing.

4. Open a terminal window.

5. In the terminal window, type the following command:

   dd if=diskboot.img of=/dev/<device>

   Replace <device> with the name of the correct device file for the media.
Beginning the Installation

To begin installation of Fedora Core, boot the computer from the bootable media. The bootable media provides the necessary programs and files to start the installation program. Once you start the installation program, you may be able to install from a completely different piece of media. For more information on finding and creating bootable media, refer to Chapter 4, Preparing Media.

If you boot from the first installation disc of the Fedora Core distribution, you may choose a different source for installation. The default source is the CDs themselves. To change this behavior, enter `linux askmethod` at the `boot:` prompt. If you boot from other media, the installation program always asks you to choose the installation source.

The BIOS (Basic Input/Output System) on your computer must support the type of boot media you select. The BIOS controls access to some hardware devices during boot time. Any computer that meets the minimum recommended specification for Fedora Core can boot from a CD or DVD drive with the first disc. USB drives and flash media are newer technologies, but many computers can use them as boot media. Some network cards and chipsets include support for network booting with PXE. PXE (pronounced “pixie”) allows a computer to load boot files from a network server instead of directly-connected hardware.

If you are not sure what capabilities your computer has, or how to configure the BIOS, consult the documentation provided by the manufacturer. Detailed information on hardware specifications and configuration is beyond the scope of this document.

Aborting the Installation

To abort the installation process at any time before the Installing Packages screen, either press `Ctrl+Alt+Del` or power off the computer with the power switch. Fedora Core makes no changes to your computer until package installation begins.

5.1. Booting from CD, DVD, or USB Media

To boot your computer:

1. Switch on the computer.

2. Insert the first disc into the CD or DVD drive, or attach the USB media.

3. A boot screen appears, with a `boot:` prompt at the bottom.

BIOS Boot Order

The BIOS contains settings that control the order of boot devices. If your PC boots from a device other than the Fedora Core boot media, check the BIOS boot configuration.
Chapter 5. Beginning the Installation

If you hit Enter, the installation runs in default mode. In the default mode, the installation uses a graphical interface if possible. If the installation program runs from the Fedora Core installation CD or DVD media, in default mode it uses these media as the installation source. To change the installation mode, at the boot: prompt, type linux followed by one or more of the following options:

- To install from a hard drive or network server, add the directive askmethod.
- To use a text interface, add the directive text.
- To retry installation because the installation aborted at an early stage, add the directive acpi=off. ACPI is responsible for many kinds of installation errors. If you turn ACPI off, you may be able to overcome some of these errors.


When you issue a command at the boot: prompt, the first stage of the installation program starts.
5.2. Testing CD and DVD Media

Select **OK** to test the disc, or select **Skip** to proceed with the installation without testing the disc.

**Testing Discs**
Test any discs which you have not previously tested. A disc error during the installation process may force you to restart the entire procedure.

After you test the first disc, another screen appears and shows the result:
Figure 5.3. Media Check Result

Select **OK**. The following screen appears:
5.3. Booting from the Network using PXE

To boot with PXE, you need a properly configured server, and a network interface in your computer that supports PXE.

Configure the computer to boot from the network interface. This option is in the BIOS, and may be labeled Network Boot or Boot Services. Once you properly configure PXE booting, the computer can boot the Fedora Core installation system without any other media.

To boot a computer from a PXE server:

1. Ensure that the network cable is attached. The link indicator light on the network socket should be lit, even if the computer is not switched on.
2. Switch on the computer.

3. A menu screen appears. Press the number key that corresponds to the desired option.

**PXE Troubleshooting**

If your PC does not boot from the netboot server, ensure that the BIOS is configured to boot first from the correct network interface. Some BIOS systems specify the network interface as a possible boot device, but do not support the PXE standard. Refer to your hardware documentation for more information.
Identifying Your Locale

If the installation system fails to identify the display hardware on your computer, it displays text screens rather than the default graphical interface. The text screens provide the same functions as the standard screens. Later in the installation process you can manually specify your display hardware.

6.1. Language Selection

The installation program displays a list of languages supported by Fedora Core.

![Figure 6.1. Language Selection Screen](image)

Highlight the correct language on the list and select Next.

### Installing Support For Additional Languages

To select support for additional languages, customize the installation at the package selection stage. For more information, refer to Section 15.2.2, "Additional Language Support".

6.2. Keyboard Configuration

The installation program display a list of the keyboard layouts supported by Fedora Core:
Highlight the correct layout on the list, and select Next.
Installation Methods

You can install Fedora Core using any of several different methods. You can install from CD or DVD media burned from downloaded ISO images, from the ISO images stored on hard disk, or from a network using NFS, FTP, or HTTP methods.

If you booted a Fedora Core DVD, or the first installation CD, without the `askmethod` option, proceed to Section 7.1, “Default Installation Method”. Otherwise, proceed to Section 7.2, “Alternative Installation Methods”.

7.1. Default Installation Method

A default installation runs directly from CD or DVD installation media. The next stage loads automatically from the installation media. Proceed to Chapter 8, Welcome Dialog.

7.2. Alternative Installation Methods

The installation method screen below appears if one of the following is true:

1. You started the installation with boot-only PXE, USB, CD, or DVD media.
2. You entered the `askmethod` option at the boot: prompt.

![Installation Method Screen](image)
Chapter 7. Installation Methods

CD/DVD Activity
If you booted with Fedora Core installation Disc 1, the installation program loads its next stage from that disc. This happens regardless of which installation method you choose, unless you eject the disc before you proceed. The installation program still downloads package data from the source you choose.

Even if you booted from alternative media, you can still install Fedora Core from CD or DVD media. Alternately, you can install from ISO images stored on your computer's hard disk, or from a network server.

- To install from CD or DVD media, insert a Fedora Core DVD or the first installation CD, select **Local CDROM**, and proceed to Chapter 8, Welcome Dialog.
- To install from ISO images on a hard disk, select **Hard drive** and proceed to Section 7.3, “Installation from a Hard Drive”.
- To install from a network, using NFS, FTP, or HTTP, proceed to Section 7.4, “Installation TCP/IP Configuration”.

### 7.3. Installation from a Hard Drive

Once you have booted your computer, you may use ISO image files of the Fedora Core discs to continue the installation process. The ISO files must be located on a hard drive that is either internal to the computer, or attached to the machine by USB. You can use this option to install Fedora Core on computers that have neither a network connection nor CD or DVD drives.

The partition on the hard drive holding the ISO files must be formatted with the **ext2**, **ext3**, or **vfat** file system. In Fedora Core, **vfat** includes a range of file systems, such as FAT-16 and FAT-32, found on most removable media. External hard drives usually contain **vfat** (FAT-32) file systems. Some Microsoft Windows systems also use **vfat** file systems on internal hard disk partitions.

Before you begin installation from a hard drive, check the partition type to ensure that Fedora Core can read it. To check a partition’s file system under Windows, use the **Disk Management** tool. To check a partition's file system under Linux, use the **fdisk** utility.

**Cannot Install from LVM Partitions**

You cannot use ISO files on partitions controlled by LVM (Logical Volume Management).

If you choose this option, the following screen appears:
Select the partition containing the ISO files from the list of available partitions. Internal IDE drive device names begin with /dev/hd. SATA, SCSI, and USB drive device names begin with /dev/sd. Each individual drive has its own letter, for example /dev/hda. Each partition on a drive is numbered, for example /dev/sda1.

Also specify the Directory holding images. Enter the full directory path from the drive that contains the ISO image files.

Select OK to continue. Proceed with Chapter 8, Welcome Dialog.

7.4. Installation TCP/IP Configuration

The installation program is network-aware and can use network settings for a number of functions. For instance, you can install Fedora Core from a network server using FTP, HTTP, or NFS protocols. You can also instruct the installation program to consult additional software repositories later in the process.

By default, the installation program uses DHCP to automatically provide network settings. If you use a cable or DSL modem, router, firewall, or other network hardware to communicate with the Internet, DHCP is a suitable option. In a business environment, consult with your network administrators for appropriate settings. If your network has no DHCP server, clear the check box labeled Use dynamic IP configuration (DHCP).

The installation program supports both IPv4 and IPv6. If you are not sure which addressing scheme your network uses, it is safe to leave both options selected.
DHCP Responses Take Time
If you select both IPv4 and IPv6 options, it may take additional time to receive network settings from the DHCP server.

If you choose a network-based installation, the following screen appears:

![Configure TCP/IP Dialog]

These settings apply only during the installation process. The installation program allows you to configure the final network configuration later.

You can install from a Web, FTP, or NFS server either on your local network or, if you are connected, on the Internet. To use a public server, or mirror website, refer to Section 3.3, “Installing from a Server or Web Site” for information on valid server names and directory paths.

Large Download
If you are not booting from a Fedora Core DVD or installation CD, a network installation downloads the main installation program from the network. The graphical installation program is over 75 MB in size.

- If you are installing via NFS, proceed to Section 7.5, “NFS Installation Setup”.
- If you are installing via FTP, proceed to Section 7.6, “FTP Installation Setup”.
• If you are installing via HTTP, proceed to Section 7.7, “HTTP Installation Setup”.

7.5. NFS Installation Setup
To install from a NFS server, select NFS from the Installation Method menu and select OK. The following screen appears:

![NFS Setup Dialog](image)

Figure 7.4. NFS Setup Dialog

Enter the name or IP address of the NFS server and the directory where the installation files reside.

**NFS Mirror Availability**
Public NFS mirrors are rare due to security concerns with NFS that do not necessarily apply to FTP or HTTP servers. The Fedora Project does not maintain a list of public NFS mirrors for Fedora Core.

Select OK to continue. Proceed with Chapter 8, Welcome Dialog.

7.6. FTP Installation Setup
To install from a FTP server, select FTP from the Installation Method menu and select OK. The following screen appears:
Enter the name or IP address of the FTP server and the directory where the installation files reside. Refer to Section 3.3, “Installing from a Server or Web Site” for information on how to locate a FTP mirror and enter its information here.

The FTP service setup dialog also has a **Use non-anonymous ftp** option. If your FTP server does not provide anonymous access, select this check box. You must have an account on the FTP server to use this option.

Select **OK** to continue. If you are using the default, anonymous FTP service, continue with Chapter 8, Welcome Dialog.

If you are using a non-anonymous FTP login, the following dialog appears:
Enter your username and password in the spaces provided. Then select OK to continue. Proceed with Chapter 8, Welcome Dialog.

### 7.7. HTTP Installation Setup

To install from a Web (HTTP) server, select HTTP from the Installation Method menu and select OK. The following screen appears:
Chapter 7. Installation Methods

Figure 7.7. HTTP Setup Dialog

Enter the name or IP address of the Web server and the directory where the installation files reside. Refer to Section 3.3, “Installing from a Server or Web Site” for information on how to locate a Web mirror and enter its information here.

Select **OK** to continue. Proceed with Chapter 8, Welcome Dialog.
Welcome Dialog

After the installation program loads its next stage, the following dialog appears:

![Welcome Screen](image)

Figure 8.1. Welcome Screen

**Installation Screens May Differ**

The installation program may continue in text mode if:

- your computer has 128 MB of memory or less
- you booted with the `text` option

The screens shown in the following chapters are based on a default graphical installation. However, most functions are similar regardless of the installation mode.

Select **Next** to continue.
Upgrading an Existing System

The installation system automatically detects any existing installation of Fedora Core. The upgrade process updates the existing system software with new versions, but does not remove any data from users' home directories. The existing partition structure on your hard drives does not change. Your system configuration changes only if a package upgrade demands it. Most package upgrades do not change system configuration, but rather install an additional configuration file for you to examine later.

9.1. Upgrade Examine

If your system contains a Fedora Core or Red Hat Linux installation, the following screen appears:

![Upgrade Examine Screen](image)

To perform an upgrade of an existing system, choose the appropriate installation from the drop-down list and select Next.

Manually Installed Software

Software which you have installed manually on your existing Fedora Core or Red Hat Linux system may behave differently after an upgrade. You may need to manually recompile this software after an upgrade to ensure it performs correctly on the updated system.
9.2. Upgrading Boot Loader Configuration

Your completed Fedora Core installation must be registered in the boot loader to boot properly. A boot loader is software on your machine that locates and starts the operating system. Refer to Chapter 11, Boot Loader for more information about boot loaders.

Figure 9.2. Upgrade Bootloader Screen

If the existing boot loader was installed by a Linux distribution, the installation system can modify it to load the new Fedora Core system. To update the existing Linux boot loader, select Update boot loader configuration. This is the default behavior when you upgrade an existing Fedora Core or Red Hat Linux installation.

GRUB is the standard boot loader for Fedora Core. If your machine uses another boot loader, such as BootMagic™, System Commander™, or the loader installed by Microsoft Windows, then the Fedora Core installation system cannot update it. In this case, select Skip boot loader updating. When the installation process completes, refer to the documentation for your product for assistance.

Install a new boot loader as part of an upgrade process only if you are certain you want to replace the existing boot loader. If you install a new boot loader, you may not be able to boot other operating systems on the same machine until you have configured the new boot loader. Select Create new boot loader configuration to remove the existing boot loader and install GRUB.

After you make your selection, click Next to continue.
Disk Partitioning

Fedora Core creates and uses several partitions on the available hard drives. You may customize both the partitions, and how the drives on your system are managed. Section 10.1, “General Information on Partitions” explains drive partitions in more detail.

Configuring RAID Devices

RAID facilities enable a group, or array, of drives to act as a single device. Configure any RAID functions provided by the mainboard of your computer, or attached controller cards, before you begin the installation process. Each active RAID array appears as one drive within Fedora Core.

On systems with more than one hard drive you may configure Fedora Core to operate several of the drives as a Linux RAID array without requiring any additional hardware. Linux software RAID arrays are explained in Section 10.2, “Disk Druid”.

Changing Your Mind

The installation process makes no changes to your system until package installation begins. You may use Back to return to previous screens and change your selections at any time.

![Partitioning Options Screen](image-url)

Figure 10.1. Partitioning Options Screen
The box on the screen lists the available drives. By default, the installation process may affect all of the drives on your computer. To ensure that specific drives are not repartitioned, clear the check box next to those drives on this list.

The installation process erases any existing Linux partitions on the selected drives, and replaces them with the default set of partitions for Fedora Core. All other types of partitions remain unchanged. For example, partitions used by Microsoft Windows, and system recovery partitions created by the computer manufacturer, are both left intact. You may choose an alternative from the drop-down list:

**Remove all partitions on selected drives and create default layout**
Avoid this option, unless you wish to erase all of the existing operating systems and data on the selected drives.

**Remove linux partitions on selected drives and create default layout**
If the selected drives have any Linux partitions, this option removes them and installs Fedora Core into the resulting free space. This option does not modify partitions assigned to other non-Linux operating systems. It does not discriminate, however, between partitions assigned to different Linux distributions, and will remove all of them.

**Use free space on selected drives and create default layout**
If the selected drives have free space that has not been assigned to a partition, this option installs Fedora Core into the free space. This option ensures that no existing partition is modified by the installation process.

**Create custom layout**
You manually specify the partitioning on the selected drives. The next screen enables you to configure the drives and partitions for your computer. If you choose this option, Fedora Core creates no partitions by default.

Select **Review and modify partitioning layout** to customize the set of partitions that Fedora Core creates, to configure your system to use drives in RAID arrays, or to modify the boot options for your computer. If you choose one of the alternative partitioning options, this is automatically selected.

Use the **Advanced storage options** option if:

- You want to install Fedora Core to a drive connected through the iSCSI protocol. Select **Advanced storage options**, then select **Add iSCSI target**, then select **Add drive**. Provide an IP address and the iSCSI initiator name, and select **Add drive**.

- You want to disable a dmraid device that was detected at boot time.

Choose a partitioning option, and select **Next** to proceed.

The next screen is **Network Devices**, explained Chapter 12, Network Configuration, unless you select an option to customize the partition layout. If you choose to either **Create custom layout**, or **Review and modify partitioning layout**, proceed to Section 10.1, “General Information on Partitions”.

**10.1. General Information on Partitions**
A Fedora Core system has at least three partitions:
• A data partition mounted at `/boot`
• A data partition mounted at `/`
• A swap partition

Many systems have more partitions than the minimum listed above. Choose partitions based on your particular system needs. For example, consider creating a separate `/home` partition on systems that store user data, for the reasons explained in Section 10.1.3, “Creating a `/home Partition”.

If you are not sure how best to configure the partitions for your computer, accept the default partition layout.

The RAM installed in your computer provides a pool of memory for running systems. Linux systems use `swap` partitions to expand this pool, by automatically moving portions of memory between RAM and swap partitions if insufficient RAM is available. In addition, certain power management features store all of the memory for a suspended system in the available swap partitions. If you manually specify the partitions on your system, create one swap partition that has more capacity than the computer RAM.

Data partitions provide storage for files. Each data partition has a `mount point`, to indicate the system directory whose contents reside on that partition. A partition with no mount point is not accessible by users. Data not located on any other partition resides in the `/` (or `root`) partition.

### Root and `/root`

The `/` (or `root`) partition is the top of the directory structure. The `/root` (sometimes pronounced “slash-root”) directory is the home directory of the user account for system administration.

In the minimum configuration shown above:

• All data under the `/boot` directory resides on the `/boot` partition. For example, the file `/boot/grub/grub.conf` resides on the `/boot` partition.
• Any file outside of the `/boot` partition, such as `/etc/passwd`, resides on the `/` partition.

Subdirectories may be assigned to partitions as well. Some administrators create both `/usr` and `/usr/local` partitions. In that case, files under `/usr/local`, such as `/usr/local/bin/foo`, are on the `/usr/local` partition. Any other files in `/usr/`, such as `/usr/bin/foo`, are in the `/usr` partition.

If you create many partitions instead of one large `/` partition, upgrades become easier. Refer to the description of Disk Druid's `Edit option` for more information.

### Leave Excess Capacity Unallocated

Only assign storage capacity to partitions that you require immediately. You may allocate free space at any time, to meet needs as they arise.
10.1.1. Partition Types

Every partition has a *partition type*, to indicate the format of the *file system* on that partition. The file system enables Linux to organize, search, and retrieve files stored on that partition. Use the *ext3* file system for data partitions that are not part of LVM, unless you have specific needs that require another type of file system.

10.1.2. Understanding LVM

LVM (Logical Volume Management) partitions provide a number of advantages over standard partitions. LVM partitions are formatted as *physical volumes*. One or more physical volumes are combined to form a *volume group*. Each volume group's total storage is then divided into one or more *logical volumes*. The logical volumes function much like standard partitions. They have a file system type, such as *ext3*, and a mount point.

The /boot Partition and LVM

Only an active Linux system may read or write to LVM volumes. For this reason, the `/boot` partition that initializes your system must be held outside of the LVM physical volumes.

An administrator may grow or shrink logical volumes without destroying data, unlike standard disk partitions. If the physical volumes in a volume group are on separate drives or RAID arrays then administrators may also spread a logical volume across the storage devices.

You may lose data if you shrink a logical volume to a smaller capacity than the data on the volume requires. To ensure maximum flexibility, create logical volumes to meet your current needs, and leave excess storage capacity unallocated. You may safely grow logical volumes to use unallocated space, as your needs dictate.

LVM and the Default Partition Layout

By default, the installation process creates data and swap partitions within LVM volumes, with a separate `/boot` partition.

10.1.3. Creating a /home Partition

If you expect that you or other users will store data on the system, create a separate partition for the `/home` directory within a volume group. With a separate `/home` partition, you may upgrade or reinstall Fedora Core without erasing user data files. LVM provides you with the ability to add more storage capacity for the user data at a later time.

10.2. Disk Druid

*Disk Druid* is an interactive program for editing disk partitions. Users run it only within the Fedora Core installation system. Disk Druid enables you to configure Linux software RAID and
LVM to provide more extensible and reliable data storage.

**Modifying the Default LVM Layout**

The default layout pools all of the available storage into a single LVM physical volume, with one LVM logical volume for the system. To make capacity available for additional partitions, **Edit** the logical volume with the mount point `/`, and reduce it's size as necessary.

![Disk Setup Screen](image)

**Figure 10.2. Disk Setup Screen**

**Disk Druid** displays the following actions in the installation program:

**New**

Select this option to add a partition or LVM physical volume to the disk. In the **Add partition** dialog, choose a mount point and a partition type. If you have more than one disk on the system, choose which disks the partition may inhabit. Indicate a size in megabytes for the partition.

**Illegal Partitions**

The `/bin/`, `/dev/`, `/etc/`, `/lib/`, `/proc/`, `/root/`, and `/sbin/` directories may not be used for separate partitions in **Disk Druid**. These directories reside on the `/ (root)` partition.
The `/boot` partition may not reside on an LVM volume group. Create the `/boot` partition before configuring any volume groups.

You may also choose from three options for sizing your partition:

**Fixed size**
Use a fixed size as close to your entry as possible.

**Fill all space up to**
Grow the partition to a maximum size of your choice.

**Fill to maximum allowable size**
Grow the partition until it fills the remainder of the selected disks.

**Partition Sizes**
The actual partition on the disk may be slightly smaller or larger than your choice. Disk geometry issues cause this effect, not an error or bug.

After you enter the details for your partition, select **OK** to continue.

**Edit**
Select this option to edit an existing partition, LVM volume group, or an LVM physical volume that is not yet part of a volume group. To change the size of a LVM physical volume partition, first remove it from any volume groups.

**Removing LVM Physical Volumes**
If you remove an LVM physical volume from a volume group, you erase any logical volumes it contains.

Edit a partition to change its size, mount point, or file system type. Use this function to:

- correct a mistake in setting up your partitions
- migrate Linux partitions if you are upgrading or reinstalling Fedora Core
- provide a mount point for non-Linux partitions such as those used on some Windows operating systems

**Windows Partitions**
You may not label Windows partitions that use the NTFS file system with a mount point in the Fedora Core installer. You may label `vfat` (FAT16 or FAT32) partitions with a mount point.

If you need to make *drastic* changes to your partition configuration, you may want to delete partitions and start again. If your disk contains data that you need to keep, back it up before you edit any partitions. If you edit the size of a partition, you may lose all data on it.
If your system contains many separate partitions for system and user data, it is easier to upgrade your system. The installation program allows you to erase or retain data on specific partitions. If your user data is on a separate /home partition, you can retain that data while erasing system partitions such as /boot.

**Delete**
- Select this option to erase an existing partition or LVM physical volume. To delete an LVM physical volume, first delete any volume groups of which that physical volume is a member.

If you make a mistake, use the Reset option to abandon all the changes you have made.

**Reset**
- Select this option to force Disk Druid to abandon all changes made to disk partitions.

**RAID**
- Select this option to set up software RAID on your Fedora Core system.

**Create a software RAID partition**
- Choose this option to add a partition for software RAID. This option is the only choice available if your disk contains no software RAID partitions.

**Create a RAID device**
- Choose this option to construct a RAID device from two or more existing software RAID partitions. This option is available if two or more software RAID partitions have been configured.

**Clone a drive to create a RAID device**
- Choose this option to set up a RAID mirror of an existing disk. This option is available if two or more disks are attached to the system.

**LVM**
- Select this option to set up LVM on your Fedora Core system. First create at least one partition or software RAID device as an LVM physical volume, using the New dialog.

To assign one or more physical volumes to a volume group, first name the volume group. Then select the physical volumes to be used in the volume group. Finally, configure logical volumes on any volume groups using the Add, Edit and Delete options.

You may not remove a physical volume from a volume group if doing so would leave insufficient space for that group’s logical volumes. Take for example a volume group made up of two 5 GB LVM physical volume partitions, which contains an 8 GB logical volume. The installer would not allow you to remove either of the component physical volumes, since that would leave only 5 GB in the group for an 8 GB logical volume. If you reduce the total size of any logical volumes appropriately, you may then remove a physical volume from the volume group. In the example, reducing the size of the logical volume to 4 GB would allow you to remove one of the 5 GB physical volumes.
LVM Unavailable in Text Installs

LVM initial set up is not available in a text-mode installation. The installer allows you to edit pre-configured LVM volumes. If you need to create an LVM configuration from scratch, hit Alt+F2 to use the terminal, and run the lvm command. To return to the text-mode installation, hit Alt+F1.

After you finish setting up and reviewing your partition configuration, select Next to continue the installation process.
Chapter 11.

Boot Loader

A boot loader is a small program that reads and launches the operating system. Fedora Core uses the GRUB boot loader by default. If you have multiple operating systems, the boot loader determines which one to boot, usually by offering a menu.

You may have a boot loader installed on your system already. An operating system may install its own preferred boot loader, or you may have installed a third-party boot loader. If your boot loader does not recognize Linux partitions, you may not be able to boot Fedora Core. Use GRUB as your boot loader to boot Linux and most other operating systems. Follow the directions in this chapter to install GRUB.

Installing GRUB

If you install GRUB, it may overwrite your existing boot loader.

The following screen displays boot loader configuration options.

![Boot Loader Configuration Screen]

11.1. Keeping Your Existing Boot Loader Settings

By default, the installation program installs GRUB in the master boot record, or MBR, of the device for the root file system. To decline installation of a new boot loader, select No boot loader will be installed.
11.2. Booting Additional Operating Systems

If you have other operating systems already installed, Fedora Core attempts to automatically detect and configure GRUB to boot them. You may manually configure any additional operating systems if GRUB does not detect them. To add, remove, or change the detected operating system settings, use the options provided.

**Add**

Press the **Add** button to include an additional operating system in GRUB. Fedora Core displays the dialog shown in *Figure 11.2, “Adding Operating Systems to the Boot Menu”*. Select the disk partition which contains the bootable operating system from the drop-down list and give the entry a label. GRUB displays this label in its boot menu.

**Edit**

To change an entry in the GRUB boot menu, select the entry and then select **Edit**.

**Delete**

To remove an entry from the GRUB boot menu, select the entry and then select **Delete**.
11.3. Setting a Boot Loader Password

GRUB reads many file systems without the help of an operating system. An operator can interrupt the booting sequence to choose a different operating system to boot, change boot options, or recover from a system error. However, these functions may introduce serious security risks in some environments. You can add a password to GRUB so that the operator must enter the password to interrupt the normal boot sequence.

GRUB Passwords Not Required

You may not require a GRUB password if your system only has trusted operators, or is physically secured with controlled console access. However, if an untrusted person can get physical access to your computer's keyboard and monitor, that person can reboot the system and access GRUB. A password is helpful in this case.

To set a boot password, select the Use a boot loader password check box. The Change password button will become active. Select Change password to display an entry dialog. Type the desired password, and then confirm it by typing it again in the spaces provided.
Choose a Good Password
Choose a password that is easy for you to remember but hard for others to guess.

11.3.1. Forgotten GRUB Passwords
GRUB stores the password in encrypted form, so it cannot be read or recovered. If you forget the boot password, boot the system normally and then change the password entry in the `/boot/grub/grub.conf` file. If you cannot boot, you may be able to use the "rescue" mode on the first Fedora Core installation disc to reset the GRUB password.

If you do need to change the GRUB password, use the `grub-md5-crypt` utility. For information on using this utility, use the command `man grub-md5-crypt` in a terminal window to read the manual pages.

11.4. Advanced Boot Loader Options
The default boot options are adequate for most situations. The installation program writes the GRUB boot loader in the master boot record (MBR), overwriting any existing boot loader.

You may keep your current boot loader in the MBR and install GRUB as a secondary boot loader. If you choose this option, the installer program will write GRUB to the first sector of the Linux `/boot` partition.

GRUB as a Secondary Boot Loader
If you install GRUB as a secondary boot loader, you must reconfigure your primary boot loader whenever you install and boot from a new kernel. The kernel of an operating system such as Microsoft Windows does not boot in the same fashion. Most users therefore use GRUB as the primary boot loader on dual-boot systems.

You may also need the advanced options if your BIOS enumerates your drives or RAID arrays differently than Fedora Core expects. If necessary, use the Change Drive Order dialog to set the order of the devices in Fedora Core to match your BIOS.

On a few systems, Fedora Core may not configure the disk drive geometry for large disks correctly because of limitations within the BIOS. To work around this problem, mark the Force LBA32 check box.

The Linux kernel usually auto-detects its environment correctly, and no additional kernel parameters are needed. However, you may provide any needed kernel parameter using the advanced boot loader options.

Kernel Parameters
For a partial list of the kernel command line parameters, type the following command in a terminal window: `man bootparam`. For a comprehensive and authoritative list, refer to the documentation provided in the kernel sources.
To alter any of these settings, mark the **Configure advanced boot loader options** check box. Select **Next** and the menu shown in *Figure 11.3, “Advanced Boot Options”* appears.

**Optional Menu**

Fedora Core displays the following advanced boot options menu *only* if the advanced configuration check box described above has been selected.

![Figure 11.3. Advanced Boot Options](image)
Network Configuration

Use this screen to customize the network settings of your Fedora Core system.

Manual network configuration of a Fedora Core system is often not required. Many networks have a DHCP (Dynamic Host Configuration Protocol) service that automatically supplies connected systems with configuration data. By default, Fedora Core activates all network interfaces on your computer and configures them to use DHCP.

![Network Configuration Screen]

12.1. Network Devices

Fedora Core displays a list of network interfaces detected on your computer. Each interface must have a unique IP address on the network to which it is attached. The interface may receive this address from the network DHCP service.

To manually assign an IP address, highlight the interface on the Network Device list and select Edit. Fedora Core then displays a network configuration dialog. Deselect the Configure using DHCP check box, so that it is empty. Enter the IP Address and the appropriate Netmask for the interface. Then select OK.

If your computer will be a server, do not use DHCP. Manually configure networking instead. Manual network configuration allows your server to join the local network even if the DHCP provider is down.
Specify whether an interface should be automatically activated at boot time with the **Active on Boot** check box for that device. You may manually activate a network interface at any time after the system has booted.

**Modem Configuration**

The **Network Configuration** screen does not list modems. Configure these devices after installation with the **Network** utility. The settings for your modem are specific to your particular Internet Service Provider (ISP).

### 12.2. Computer Hostname

On some networks, the DHCP provider also provides the name of the computer, or **hostname**. To specify the hostname, select **Manual** and type the complete name in the box. The complete hostname includes both the name of the machine and the name of the domain of which it is a member, such as `machine1.example.com`. The machine name (or "short hostname") is `machine1`, and the domain name is `example.com`.

**Valid Hostnames**

You may give your system any name provided that the full hostname is unique. The hostname may include letters, numbers and hyphens.

### 12.3. Miscellaneous Settings

To manually configure a network interface, you may also provide other network settings for your computer. All of these settings are the IP addresses of other systems on the network.

A **gateway** is the device that provides access to other networks. Gateways are also referred to as **routers**. If your system connects to other networks through a gateway, enter its IP address in the **Gateway** box.

Most software relies on the **DNS** (Domain Name Service) provider to locate machines and services on the network. DNS converts hostnames to IP addresses and vice versa. A Fedora Core system may use more than one DNS server. If the primary DNS server does not respond, the computer sends any query to the secondary DNS server, and so on. To assign DNS servers, type their IP addresses into the **Primary**, **Secondary**, or **Tertiary DNS Server** boxes.

Click **Next** once you are satisfied with the network settings for your system.
Chapter 13.

Time Zone Selection

This screen allows you to specify the correct time zone for the location of your computer. Specify a time zone even if you plan to use NTP (Network Time Protocol) to maintain the accuracy of the system clock.

13.1. Selecting a Time Zone

Fedora Core displays on the screen two methods for selecting the time zone.

![Time Zone Selection Screen](image)

To select a time zone using the map, first place your mouse pointer over your region on the map. Click once to magnify that region on the map. Next, select the yellow dot that represents the city nearest to your location. Once you select a dot, it becomes a red X to indicate your selection.

To select a time zone using the list, select the name of the city nearest to your location. The cities are listed in alphabetical order.

13.2. Universal Co-ordinated Time (UTC)

Universal Co-ordinated Time is also known as Greenwich Mean Time (GMT).

If Fedora Core is the only operating system on your computer, select **System clock uses UTC**. The system clock is a piece of hardware on your computer system. Fedora Core uses the timezone setting
to determine the offset between the local time and UTC on the system clock. This behavior is standard for UNIX-like operating systems.

**Windows and the System Clock**

Do not enable the **System clock uses UTC** option if your machine also runs Microsoft Windows. Microsoft operating systems change the BIOS clock to match local time rather than UTC. This may cause unexpected behavior under Fedora Core.

Select **Next** to proceed.
Set the Root Password

Fedora Core uses a special account named root for system administration. The root account on a Linux system is not subject to most normal account restrictions. As the system owner or administrator, you may sometimes require special privileges to configure or modify the system. In those cases, use the root account.

Using the root Account

Avoid logging in to Fedora Core as root when possible. Any administration tools which require root privileges will prompt you for the password.

The Fedora Core installation program requires the root password to be at least six characters long. Because the root account may potentially control any part of the system, use the following guidelines to create a good password:

- Use a combination of uppercase letters, lowercase letters, numbers, punctuation and other characters.
- Do not use a word or name. Obscuring the word or name with substitute characters is not effective.
- Do not use the same password for more than one system.

The following are examples of good passwords:

- f9*@1Ls99A
- HL8$391%r'b
- Iwtb,10^th

Enter the root password into the Root Password field. Fedora Core displays the characters as asterisks for security. Type the same password into the Confirm field to ensure it is set correctly.
Chapter 14. Set the Root Password

Figure 14.1. Set Root Password Screen

After you set the root password, select Next to proceed.
Software Selection

By default, the Fedora Core installation process loads a selection of software that is suitable for a desktop system.

Figure 15.1. Task Selection Screen

To include or remove software for common tasks, select the relevant items from the list:

Office and Productivity
- This option provides the OpenOffice.org productivity suite, the Planner project management application, graphical tools such as the GIMP, and multimedia applications.

Software Development
- This option provides the necessary tools to compile software on your Fedora Core system.

Web server
- This option provides the Apache Web server.

15.1. Installing from Additional Repositories

You can define additional repositories to increase the software available to your system during installation. A repository is a network location that stores software packages along with metadata that describes them. Many of the software packages used in Fedora Core require other software to be installed. The installer uses the metadata to ensure that these requirements are met for every piece of software you select for installation.
Chapter 15. Software Selection

The Fedora Extras software repository contains thousands of additional packages you can add at installation time if desired. To add the Fedora Extras software repository to the installation program, select **Fedora Extras** from the repository listing. Fedora Extras is already defined in the installation program and requires no further input. For more information about Fedora Extras, refer to the **Release Notes** or [http://fedoraproject.org/wiki/Extras](http://fedoraproject.org/wiki/Extras).

**Fedora Extras and Network Connectivity**
The Fedora Extras repository selection is available if your computer has a connection to the internet.

To include software from repositories other than Fedora Core and Fedora Extras, select **Add additional software repositories**. The following list includes examples of ways you can use this option.

- **Get the Latest Fedora Software**
  If you provide the location of a repository of updates for Fedora Core, your system will have the most recent versions of Core software. You will not need to perform a system update immediately after installation to get these updates. This usage is ideal if you are installing over the Internet or any network where bandwidth is a concern.

**Upgrading and Updates**
Package updates during the release cycle of a single version of Fedora Core are intended to upgrade only that version. If you are upgrading a previous version of Fedora Core, you may encounter problems if you include an update repository during this step. Problems are less likely when performing a fresh installation.

- **Install Third-party Software**
  You may provide the location of a repository of third-party software. Depending on the configuration of that repository, you may be able to select non-Fedora software during installation.

If you select **Add additional software repositories**, the following dialog appears:
Installing from Additional Repositories

Figure 15.2. Add Repository Screen

Provide a name for the repository and the URL for its location. Here are some URLs for listings of specific Fedora software repository mirrors.

- Fedora Core Updates - http://fedora.redhat.com/download/mirrors/updates-released-fc6

The URLs above provide a list of actual mirrors. You cannot use them verbatim in the Add repository dialog. Visit the URL for a list of actual repository locations. If you see the text $ARCH$ in the URL, substitute your system's architecture. See Chapter 2, Understanding i386 and Other Computer Architectures for more information on architectures.

Once you provide information for an additional repository, the installer reads the package metadata over the network. Software that is specially marked is then included in the package group selection system. See Section 15.2, “Customizing the Software Selection” for more information on selecting packages.

Backtracking Erases Added Repository Data

If you choose Back from the package selection screen, any extra repository data you may have entered is lost. This allows you to effectively cancel extra repositories. Currently there is no way to cancel only a single repository once entered.
15.2. Customizing the Software Selection

Select Customize now to specify the software packages for your final system in more detail. This option causes the installation process to display an additional customization screen when you select Next.

Installing Support for Additional Languages

Select Customize now to install support for additional languages. Refer to Section 15.2.2, “Additional Language Support” for more information on configuring language support.

Fedora Core divides the included software into package groups. For ease of use, the package selection screen displays these groups as six categories:

![Package Group Selection Screen](attachment:image.png)

Figure 15.3. Package Group Selection Screen

To view the package groups for a category, select the category from the list on the left. The list on the right displays the package groups for the currently selected category.

To specify a package group for installation, select the check box next to the group. The box at the bottom of the screen displays the details of the package group that is currently highlighted. None of the packages from a group will be installed unless the check box for that group is selected.

If you select a package group, Fedora Core automatically installs the base and mandatory packages for that group. To change which optional packages within a selected group will be installed, select the

---

None of the packages from a group will be installed unless the check box for that group is selected.
Optional Packages button under the description of the group. Then use the check box next to an individual package name to change its selection.

![Package Group Details Dialog](image)

Figure 15.4. Package Group Details Dialog

After you choose the desired packages, select Next to proceed. Fedora Core checks your selection, and automatically adds any extra packages required to use the software you select.

15.2.1. Changing Your Mind

The packages that you select are not permanent. After you boot your system, use the pirut tool to either install new software or remove installed packages. To run this tool, from the main menu, select Applications → Add/Remove Software. The Fedora Core software management system downloads the latest packages from network servers, rather than using those on the installation discs.

15.2.2. Additional Language Support

Your Fedora Core system automatically supports the language that you selected at the start of the installation process. To include support for additional languages, select the package group for those languages from the Languages category.

15.2.3. Core Network Services

All Fedora Core installations include the following network services:

- centralized logging through syslog
Chapter 15. Software Selection

- email through SMTP (Simple Mail Transfer Protocol)
- network file sharing through NFS (Network File System)
- remote access through SSH (Secure SHell)
- resource advertising through mDNS (multicast DNS)

The default installation also provides:

- network file transfer through HTTP (HyperText Transfer Protocol)
- printing through CUPS (Common UNIX Printing System)
- remote desktop access through VNC (Virtual Network Computing)

Some automated processes on your Fedora system use the email service to send reports and messages to the system administrator. By default, the email, logging, and printing services do not accept connections from other systems. Fedora Core installs the NFS sharing, HTTP, and VNC components without enabling those services.

You may configure your Fedora system after installation to offer email, file sharing, logging, printing and remote desktop access services. The SSH service is enabled by default. You may use NFS to access files on other systems without enabling the NFS sharing service.
About to Install

No changes are made to your computer until you click the **Next** button. If you abort the installation process after that point, the Fedora Core system will be incomplete and unusable. To return to previous screens to make different choices, select **Back**. To abort the installation, turn off the computer.

**Aborting Installation**

In certain situations, you may be unable to return to previous screens. Fedora Core notifies you of this restriction and allows you to abort the installation program. You may reboot with the installation media to start over.

![About to Install Screen](image)

**Figure 16.1. About to Install Screen**

Click **Next** to begin the installation.
Installing Packages

Fedora Core reports the installation progress on the screen as it writes the selected packages to your system. Network and DVD installations require no further action. If you are using CDs to install, Fedora Core prompts you to change discs periodically. After you insert a disc, select OK to resume the installation.

Figure 17.1. Installing Packages Screen

After installation completes, select Reboot to restart your computer. Fedora Core ejects any loaded discs before the computer reboots.
First Boot

The **Setup Agent** launches the first time that you start a new Fedora Core system. Use **Setup Agent** to configure the system for use before you log in.

![Welcome Screen](Welcome.png)

**Figure 18.1. Welcome Screen**

Select **Forward** to start the **Setup Agent**.

### Graphical Interface Required

**Setup Agent** requires a graphical interface. If you did not install one, or if Fedora Core has trouble starting it, you may see a slightly different setup screen.

### 18.1. License Agreement

This screen displays the overall licensing terms for Fedora Core. Each software package in Fedora Core is covered by its own license which has been approved by the Open Source Initiative (OSI). For more information about the OSI, refer to [http://www.opensource.org/](http://www.opensource.org/).
To proceed, select **Yes, I agree to the License Agreement** and then select **Forward**.

### 18.2. Firewall

The *firewall* built into Fedora Core checks every incoming and outgoing network connection on your machine against a set of rules. These rules specify which types of connections are permitted and which are denied.

By default the firewall is enabled, with a simple set of rules that allow connections to be made from your system to others, but permit only network browsing and SSH (Secure SHell) connections from other systems. You may make changes on this screen to allow access to specific network services on your Fedora Core system.
To enable access to the services listed on this screen, click the check box next to the service name.

**SSH Provides Immediate Remote Access**

All Fedora Core systems automatically run the SSH remote access service, and the default firewall configuration allows connections to this service. The default configuration ensures that administrators have immediate remote access to new systems through the user and root accounts.

To enable access to other services, select **Other ports**, and **Add** the details. Use the **Port(s)** field to specify either the port number, or the registered name of the service. Select the relevant **Protocol** from the drop-down. The majority of services use the TCP protocol.

**The Services List**

The `/etc/services` file lists service port numbers and names that are registered with the Internet Assigned Names Authority (IANA).

If a service uses more than one port number, enter each port. For example, an IMAP service enables users to access their e-mail from another system through TCP port 143. To permit IMAP connections to your system, add `imap` or port number **143**.

Avoid disabling the firewall. If you believe that it is necessary to do so, select **No firewall**.
18.3. SELinux

The SELinux (Security Enhanced Linux) framework is part of Fedora Core. SELinux limits the actions of both users and programs by enforcing security policies throughout the operating system. Without SELinux, software bugs or configuration changes may render a system more vulnerable. The restrictions imposed by SELinux policies provide extra security against unauthorized access.

Inflexible SELinux policies might inhibit many normal activities on a Fedora Core system. For this reason, Fedora Core uses targeted policies, which only affect specific network services. These services cannot perform actions that are not part of their normal functions. The targeted policies reduce or eliminate any inconvenience SELinux might cause users. Set the SELinux mode to one of the following:

**Enforcing**

Select this mode to use the targeted SELinux policy on your Fedora Core system. This is the default mode for Fedora Core installations.
Permissive
In this mode, the system is configured with SELinux, but a breach of security policies only causes an error message to appear. No activities are actually prohibited when SELinux is installed in this mode. You may change the SELinux mode to **Enforcing** at any time after booting.

Disabled
If you choose this mode for SELinux, Fedora Core does not configure the access control system at all. To make SELinux active later, select **System → Administration → Security Level and Firewall**.

To adjust SELinux, choose **Modify SELinux Policy**. To exempt a key service from SELinux restrictions, select the service from the list, and choose the **Disable SELinux protection** option. The **SELinux Service Protection** item on the list includes options to disable SELinux restrictions on additional services.

---

**Changing the SELinux policy**
SELinux is unique in that it cannot be bypassed, even by the system administrators. To change the behavior of SELinux after installation, choose **System → Administration → Security Level and Firewall**.

For more information about SELinux, refer to the SELinux FAQ at [http://fedora.redhat.com/docs/selinux-faq/](http://fedora.redhat.com/docs/selinux-faq/).

---

**18.4. Date and Time**
If your system does not have Internet access or a network time server, manually set the date and time for your system on this screen. Otherwise, use **NTP** (Network Time Protocol) servers to maintain the accuracy of the clock. NTP provides time synchronization service to computers on the same network. The Internet contains many computers that offer public NTP services.

The initial display enables you to set the date and time of your system manually.
Select the **Network Time Protocol** tab to configure your system to use NTP servers instead.

![Date and Time Screen, Local Clock](image)

**Figure 18.5. Date and Time Screen, Local Clock**

To configure your system to use network time servers, select the **Enable Network Time Protocol** option. This option disables the settings on the **Date and Time** tab and enables the other settings on this screen.
By default, Fedora Core is configured to use three separate groups, or pools, of time servers. Time server pools create redundancy, so if one time server is unavailable, your system synchronizes with another server.

To use an additional time server, select Add, and type the DNS name of the server into the box. To remove a server or server pool from the list, select the name and click Delete.

If the hardware clock in your computer is highly inaccurate, you may turn off your local time source entirely. To turn off the local time source, select Show advanced options and then deselect the Use Local Time Source option. If you turn off your local time source, the NTP servers take priority over the internal clock.

If you enable the Enable NTP Broadcast advanced option, Fedora Core attempts to automatically locate time servers on the network.

18.5. System User
Create a user account for yourself with this screen. Always use this account to log in to your Fedora Core system, rather than using the root account.
Enter a user name and your full name, and then enter your chosen password. Type your password once more in the **Confirm Password** box to ensure that it is correct. Refer to *Chapter 14, Set the Root Password* for guidelines on selecting a secure password.

### Creating Extra User Accounts

To add additional user accounts to your system after the installation is complete, choose **System → Administration → Users & Groups**.

To configure Fedora Core to use network services for authentication or user information, select **Use Network Login**.

### 18.6. Sound Card

The **Setup Agent** automatically attempts to identify the sound card in your computer.
Click the play button to check the sound card configuration. If the configuration is correct, Fedora Core plays a sound sequence. You may adjust the volume with the slidebar. The Repeat option causes the sound to play until the option is unselected, to assist you in tuning your system.

If your sound card is identified, but you do not hear the sound, check your speakers and try again. In some cases, you may need to alter the additional settings to obtain the best sound quality.

A sound card may provide multiple audio input and output devices. To change the Default PCM device, select a new option from the drop-down list. By default, audio applications connect to a software mixer that manages the PCM devices. To enable applications to bypass the software mixer, select the option to Disable software mixing.

You may manually configure a Fedora Core system to use unsupported sound cards after the installation process is complete. Manual sound hardware configuration is beyond the scope of this document.

### Changing the Sound Card

Fedora Core automatically attempts to detect a new sound card if you add one to your system. If you need to launch the detection process manually, choose System → Administration → Soundcard Detection.

After you configure the sound card, select Finish to proceed to the login screen. Your Fedora Core system is now ready for use.
Update Your System
To ensure the security of your system, run a package update after the installation completes. *Chapter 19, Your Next Steps* explains how to update your Fedora Core system.
Your Next Steps

Fedora Core provides you with a complete operating system with a vast range of capabilities, supported by a large community.

19.1. Updating Your System

The Fedora Project releases updated software packages for Fedora Core throughout the support period of each version. Updated packages add new features, improve reliability, resolve bugs, or remove security vulnerabilities. To ensure the security of your system, update regularly, and as soon as possible after a security announcement is issued. Refer to Section 19.2, “Subscribing to Fedora Core Announcements and News” for information on the Fedora Core announcements services.

A new update applet, called puplet, reminds you of updates when they are available. The puplet applet is installed by default in Fedora Core. It checks for software updates from all configured repositories, and runs as a background service. It generates a notification message on the desktop if updates are found, and you can click the message to update your system's software.

To update your system with the latest packages manually, use the Software Updater:

2. When prompted, enter the root password.
3. Review the list of updated packages. The package list displays a double arrow next to any updates that require a system reboot to take effect.
4. Click Apply Updates to begin the update process.
5. If one or more updates require a system reboot, the update process displays a dialog with the option to Reboot Now. Either select this option to reboot the system immediately, or Cancel it and reboot the system at a more convenient time.

To update packages from the command-line, use the yum utility. Type this command to begin a full update of your system with yum:

```
su -c 'yum update'
```

Enter the root password when prompted.

Refer to http://fedora.redhat.com/docs/yum/ for more information on yum.

Network Connection Required

Ensure that your system has an active network connection before you run the Software Updater, or the yum utility. The update process downloads information and packages from a network of servers.

If your Fedora Core system has a permanent network connection, you may choose to enable daily system updates. To enable automatic updates, follow the instructions on the webpage http://fedora.redhat.com/docs/yum/sn-updating-your-system.html.
19.2. Subscribing to Fedora Core Announcements and News
To receive information about package updates, subscribe to either the announcements mailing list, or the RSS feeds.

Fedora Project announcements mailing list
https://www.redhat.com/mailman/listinfo/fedora-announce-list

Fedora Project RSS feeds
http://fedoraproject.org/infofeed/

The announcements mailing list also provides you with news on the Fedora Project, and the Fedora Core community.

Security Announcements
Announcements with the keyword [SECURITY] in the title identify package updates that resolve security vulnerabilities.

19.3. Finding Documentation and Support
Members of the Fedora Core community provides support through mailing lists, Web forums and Linux User Groups (LUGs) across the world.

The Web site for the formally endorsed forums is http://forums.fedoraproject.org/.

The following resources provide information on many aspects of Fedora Core:

- The FAQ on the Fedora Project website
  http://fedoraproject.org/wiki/FAQ/

- The documents available from the Fedora Documentation Project Web site
  http://fedoraproject.org/wiki/Docs/

- The Linux Documentation Project (LDP)
  http://www.tldp.org/

- The Red Hat Enterprise Linux documentation, much of which also applies to Fedora Core
  http://www.redhat.com/docs/manuals/enterprise/

Many other organizations and individuals also provide tutorials and HOWTOs for Fedora Core on their Web sites. You can locate information on any topic by using Google's Linux search site, located at http://www.google.com/linux.

19.4. Joining the Fedora Core Community
The Fedora Project is driven by the individuals that contribute to it. Community members provide support and documentation to other users, help to improve the software included in Fedora Core by testing, and develop new software alongside the programmers employed by Red Hat. The results of this work are available to all.

To make a difference, start here:
http://fedoraproject.org/wiki/HelpWanted
Appendix A. Boot Options

The Fedora Core installation system includes a range of functions and options for administrators. To use boot options, enter `linux option` at the `boot:` prompt.

If you specify more than one option, separate each of the options by a single space. For example:

```
linux option1 option2 option3
```

Rescue Mode

The Fedora Core installation and rescue discs may either boot with rescue mode, or load the installation system. For more information on rescue discs and rescue mode, refer to Section A.6.2, “Booting Your Computer with the Rescue Mode”.

A.1. Configuring the Installation System at the `boot:` Prompt

You can use the `boot:` prompt to specify a number of settings for the installation system, including:

- language
- display resolution
- interface type
- Installation method
- network settings

A.1.1. Specifying the Language

To set the language for both the installation process and the final system, specify the ISO code for that language with the `lang` option. Use the `keymap` option to configure the correct keyboard layout.

For example, the ISO codes `el_GR` and `gr` identify the Greek language and the Greek keyboard layout:

```
linux lang=el_GR keymap=gr
```

A.1.2. Configuring the Interface

You may force the installation system to use the lowest possible screen resolution (640x480) with the `lowres` option. To use a specific display resolution, enter `resolution=setting` as a boot option. For example, to set the display resolution to 1024x768, enter:

```
linux resolution=1024x768
```
To run the installation process in text mode, enter:

```
linux text
```

To enable support for a serial console, enter `serial` as an additional option.

### A.1.3. Specifying the Installation Method

Use the `askmethod` option to display additional menus that enable you to specify the installation method and network settings. You may also configure the installation method and network settings at the `boot:` prompt itself.

To specify the installation method from the `boot:` prompt, use the `method` option. Refer to Table A.1, "Installation Methods" for the supported installation methods.

<table>
<thead>
<tr>
<th>Installation Method</th>
<th>Option Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>CD or DVD drive</td>
<td><code>method=cdrom</code></td>
</tr>
<tr>
<td>Hard Drive</td>
<td><code>method=hd://device/</code></td>
</tr>
<tr>
<td>HTTP Server</td>
<td><code>method=http://server.mydomain.com/directory/</code></td>
</tr>
<tr>
<td>NFS Server</td>
<td><code>method=nfs://server.mydomain.com:/directory/</code></td>
</tr>
</tbody>
</table>

Table A.1. Installation Methods

### A.1.4. Manually Configuring the Network Settings

By default, the installation system uses DHCP to automatically obtain the correct network settings. To manually configure the network settings yourself, either enter them in the Configure TCP/IP screen, or at the `boot:` prompt. You may specify the `ip` address, `netmask`, `gateway`, and `dns` server settings for the installation system at the prompt. If you specify the network configuration at the `boot:` prompt, these settings are used for the installation process, and the Configure TCP/IP screen does not appear.

This example configures the network settings for an installation system that uses the IP address 192.168.1.10:

```
linux ip=192.168.1.10 netmask=255.255.255.0 gateway=192.168.1.1 dns=192.168.1.2,192.168.1.3
```

### Configuring the Installed System

Use the Network Configuration screen to specify the network settings for the new system. Refer to Chapter 12, Network Configuration for more information on configuring the network settings for the installed system.
A.2. Enabling Remote Access to the Installation System

You may access either graphical or text interfaces for the installation system from any other system. Access to a text mode display requires `telnet`, which is installed by default on Fedora Core systems. To remotely access the graphical display of an installation system, use client software that supports the VNC (Virtual Network Computing) display protocol. A number of providers offer VNC clients for Microsoft Windows and Mac OS, as well as UNIX-based systems.

### Installing a VNC Client on Fedora Core

 Fedora Core includes `vncviewer`, the client provided by the developers of VNC. To obtain `vncviewer`, install the `vnc` package.

The installation system supports two methods of establishing a VNC connection. You may start the installation, and manually login to the graphical display with a VNC client on another system. Alternatively, you may configure the installation system to automatically connect to a VNC client on the network that is running in listening mode.

#### A.2.1. Enabling Remote Access with VNC

To enable remote graphical access to the installation system, enter two options at the prompt:

```
linux vnc vncpassword=qwerty
```

The `vnc` option enables the VNC service. The `vncpassword` option sets a password for remote access. The example shown above sets the password as `qwerty`.

### VNC Passwords

The VNC password must be at least six characters long.

Specify the language, keyboard layout and network settings for the installation system with the screens that follow. You may then access the graphical interface through a VNC client. The installation system displays the correct connection setting for the VNC client:

```
Starting VNC...
The VNC server is now running.
Please connect to computer.mydomain.com:1 to begin the install...
Starting graphical installation...
Press <enter> for a shell
```

You may then login to the installation system with a VNC client. To run the `vncviewer` client on Fedora Core, choose `Applications → Accessories → VNC Viewer`, or type the command `vncviewer` in a terminal window. Enter the server and display number in the `VNC Server` dialog. For the example above, the `VNC Server` is `computer.mydomain.com:1`.

#### A.2.2. Connecting the Installation System to a VNC Listener

To have the installation system automatically connect to a VNC client, first start the client in
listening mode. On Fedora Core systems, use the `-listen` option to run `vncviewer` as a listener. In a
terminal window, enter the command:

```
vncviewer -listen
```

**Firewall Reconfiguration Required**
By default, `vncviewer` uses TCP port 5500 when in listening mode. To permit connections
to this port from other systems, choose `System → Administration → Security Level and
Firewall`. Select `Other ports`, and `Add`. Enter `5500` in the `Port(s)` field, and specify `tcp`
as the `Protocol`.

Once the listening client is active, start the installation system and set the VNC options at the `boot:
prompt`. In addition to `vnc` and `vncpassword` options, use the `vncconnect` option to specify the
name or IP address of the system that has the listening client. To specify the TCP port for the listener,
add a colon and the port number to the name of the system.

For example, to connect to a VNC client on the system `desktop.mydomain.com` on the port 5500,
enter the following at the `boot:` prompt:

```
linux vnc vncpassword=qwerty vncconnect=desktop.mydomain.com:5500
```

**A.2.3. Enabling Remote Access with Telnet**
To enable remote access to a text mode installation, use the `telnet` option at the `boot:` prompt:

```
linux text telnet
```

You may then connect to the installation system with the `telnet` utility. The `telnet` command
requires the name or IP address of the installation system:

```
telnet computer.mydomain.com
```

**Telnet Access Requires No Password**
To ensure the security of the installation process, only use the `telnet` option to install
systems on networks with restricted access.

**A.3. Logging to a Remote System During the Installation**
By default, the installation process sends log messages to the console as they are generated. You
may specify that these messages go to a remote system that runs a `syslog` service.
To configure remote logging, add the `syslog` option. Specify the IP address of the logging system, and the UDP port number of the log service on that system. By default, syslog services that accept remote messages listen on UDP port 514.

For example, to connect to a syslog service on the system 192.168.1.20, enter the following at the boot: prompt:

```
linux syslog=192.168.1.20:514
```

### A.3.1. Configuring a Log Server

Fedora Core uses `syslogd` to provide a syslog service. The default configuration of `syslogd` rejects messages from remote systems.

#### Only Enable Remote Syslog Access on Secured Networks

The `syslogd` service includes no security measures. Crackers may slow or crash systems that permit access to the logging service, by sending large quantities of false log messages. In addition, hostile users may intercept or falsify messages sent to the logging service over the network.

To configure a Fedora Core system to accept log messages from other systems on the network, edit the file `/etc/sysconfig/syslog`. You must use root privileges to edit the file `/etc/sysconfig/syslog`. Add the option `-r` to the `SYLOGD_OPTIONS`:

```
SYSLOGD_OPTIONS="-m 0 -r"
```

Restart the `syslogd` service to apply the change:

```
su -c '/sbin/service syslog restart'
```

Enter the root password when prompted.

#### Firewall Reconfiguration Required

By default, the syslog service listens on UDP port 514. To permit connections to this port from other systems, choose System → Administration → Security Level and Firewall. Select Other ports, and Add. Enter 514 in the Port(s) field, and specify udp as the Protocol.

### A.4. Automating the Installation with Kickstart

A Kickstart file specifies settings for an installation. Once the installation system boots, it can read a Kickstart file and carry out the installation process without any further input from a user.
Every Installation Produces a Kickstart File

The Fedora Core installation process automatically writes a Kickstart file that contains the settings for the installed system. This file is always saved as /root/anaconda-ks.cfg. You may use this file to repeat the installation with identical settings, or modify copies to specify settings for other systems.

Fedora Core includes a graphical application to create and modify Kickstart files by selecting the options that you require. Use the package system-config-kickstart to install this utility. To load the Fedora Core Kickstart editor, choose Applications → System Tools → Kickstart.

Kickstart files list installation settings in plain text, with one option per line. This format lets you modify your Kickstart files with any text editor, and write scripts or applications that generate custom Kickstart files for your systems.

To automate the installation process with a Kickstart file, use the ks option to specify the name and location of the file:

```
linux ks=location/kickstart-file.cfg
```

You may use Kickstart files that are held on either removable storage, a hard drive, or a network server. Refer to Table A.2, “Kickstart Sources” for the supported Kickstart sources.

<table>
<thead>
<tr>
<th>Kickstart Source</th>
<th>Option Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>CD or DVD drive</td>
<td>ks=cdrom:/directory/ks.cfg</td>
</tr>
<tr>
<td>Hard Drive</td>
<td>ks=hd:/device/directory/ks.cfg</td>
</tr>
<tr>
<td>Other Device</td>
<td>ks=file:/device/directory/ks.cfg</td>
</tr>
<tr>
<td>HTTP Server</td>
<td>ks=<a href="http://server.mydomain.com/directory/ks.cfg">http://server.mydomain.com/directory/ks.cfg</a></td>
</tr>
<tr>
<td>FTP Server</td>
<td>ks=ftp://server.mydomain.com/directory/ks.cfg</td>
</tr>
<tr>
<td>NFS Server</td>
<td>ks=nfs:server.mydomain.com:/directory/ks.cfg</td>
</tr>
</tbody>
</table>

Table A.2. Kickstart Sources

To obtain a Kickstart file from a script or application on a Web server, specify the URL of the application with the ks= option. If you add the option kssendmac, the request also sends HTTP headers to the Web application. Your application can use these headers to identify the computer. This line sends a request with headers to the application http://server.mydomain.com/kickstart.cgi:

```
linux ks=http://server.mydomain.com/kickstart.cgi kssendmac
```

A.5. Enhancing Hardware Support

By default, Fedora Core attempts to automatically detect and configure support for all of the components of your computer. Fedora Core supports the majority of hardware in common use with the
software drivers that are included with the operating system. To support other devices you may supply additional drivers during the installation process, or at a later time.

A.5.1. Adding Hardware Support with Driver Disks

The installation system can load drivers from disks, pen drives, or network servers to configure support for new devices. After the installation is complete, remove any driver disks and store them for later use.

Hardware manufacturers may supply driver disks for Fedora Core with the device, or provide image files to prepare the disks. To obtain the latest drivers, download the correct file from the website of the manufacturer.

Driver Disks Supplied as Zipped Files

Driver disk images may be distributed as compressed archives, or zip files. For identification, the names of zip files include the extensions .zip, or .tar.gz. To extract the contents of a zipped file with a Fedora Core system, choose Applications → Accessories → Archive Manager.

To format a disk or pen drive with an image file, use the `dd` utility. For example, to prepare a diskette with the image file `drivers.img`, enter this command in a terminal window:

```
dd if=drivers.img of=/dev/fd0
```

To use a driver disk in the installation process, specify the `dd` option at the `boot:` prompt:

```
linux dd
```

When prompted, select Yes to provide a driver disk. Choose the drive that holds the driver disk from the list on the Driver Disk Source text screen.

The installation system can also read drivers from disk images that are held on network servers. Refer to Table A.3, "Driver Disk Image Sources" for the supported sources of driver disk image files.

<table>
<thead>
<tr>
<th>Image Source</th>
<th>Option Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a drive or device</td>
<td><code>dd</code></td>
</tr>
<tr>
<td>HTTP Server</td>
<td><code>dd=http://server.mydomain.com/directory/drivers.img</code></td>
</tr>
<tr>
<td>FTP Server</td>
<td><code>dd=ftp://server.mydomain.com/directory/drivers.img</code></td>
</tr>
<tr>
<td>NFS Server</td>
<td><code>dd=nfs://server.mydomain.com/directory/drivers.img</code></td>
</tr>
</tbody>
</table>

Table A.3. Driver Disk Image Sources
A.5.2. Overriding Automatic Hardware Detection
For some models of device automatic hardware configuration may fail, or cause instability. In these cases, you may need to disable automatic configuration for that type of device, and take additional steps to manually configure the device after the installation process is complete.

Check the Release Notes
Refer to the Release Notes for information on known issues with specific devices.

To override the automatic hardware detection, use one or more of the following options:

<table>
<thead>
<tr>
<th>Compatibility Setting</th>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable all hardware detection</td>
<td>noprobe</td>
</tr>
<tr>
<td>Disable graphics, keyboard, and mouse detection</td>
<td>headless</td>
</tr>
<tr>
<td>Disable automatic monitor detection (DDC)</td>
<td>skipddc</td>
</tr>
<tr>
<td>Disable mainboard APIC</td>
<td>noapic</td>
</tr>
<tr>
<td>Disable power management (ACPI)</td>
<td>acpi=off</td>
</tr>
<tr>
<td>Disable Direct Memory Access (DMA) for IDE drives</td>
<td>ide=nodma</td>
</tr>
<tr>
<td>Disable BIOS-assisted RAID</td>
<td>nodmraid</td>
</tr>
<tr>
<td>Disable Firewire device detection</td>
<td>nofirewire</td>
</tr>
<tr>
<td>Disable parallel port detection</td>
<td>noparport</td>
</tr>
<tr>
<td>Disable PC Card (PCMCIA) device detection</td>
<td>nopcmcia</td>
</tr>
<tr>
<td>Disable USB storage device detection</td>
<td>nousbstorage</td>
</tr>
<tr>
<td>Disable all USB device detection</td>
<td>nousb</td>
</tr>
<tr>
<td>Force Firewire device detection</td>
<td>firewire</td>
</tr>
<tr>
<td>Prompt user for ISA device configuration</td>
<td>isa</td>
</tr>
</tbody>
</table>

Table A.4. Hardware Options

Additional Screen
The isa option causes the system to display an additional text screen at the beginning of the installation process. Use this screen to configure the ISA devices on your computer.

A.6. Using the Maintenance Boot Modes

A.6.1. Loading the Memory (RAM) Testing Mode
Faults in memory modules may cause your system to freeze or crash unpredictably. In some cases, memory faults may only cause errors with particular combinations of software. For this reason, you should test the memory of a computer before you install Fedora Core for the first time, even if it has previously run other operating systems.
To boot your computer in memory testing mode, enter `memtest86` at the `boot:` prompt. The first test starts immediately. By default, `memtest86` carries out a total of ten tests.

To halt the tests and reboot your computer, enter `Esc` at any time.

**A.6.2. Booting Your Computer with the Rescue Mode**

You may boot a command-line Linux system from either a rescue disc or the first installation disc, without installing Fedora Core on the computer. This enables you to use the utilities and functions of a running Linux system to modify or repair systems that are already installed on your computer.

The rescue disc starts the rescue mode system by default. To load the rescue system with the first installation disc, enter:

```
linux rescue
```

Specify the language, keyboard layout and network settings for the rescue system with the screens that follow. The final setup screen configures access to the existing system on your computer.

By default, rescue mode attaches an existing operating system to the rescue system under the directory `/mnt/sysimage/`. 
Appendix B. Other Technical Documentation

This document provides a reference for using the Fedora Core installation software, known as *anaconda*. To learn more about *anaconda*, visit the project Web page: [http://www.fedoraproject.org/wiki/Anaconda](http://www.fedoraproject.org/wiki/Anaconda).

Both *anaconda* and Fedora Core systems use a common set of software components. For detailed information on key technologies, refer to the Web sites listed below:

**Boot Loader**
Fedora Core uses the **GRUB** boot loader. Refer to [http://www.gnu.org/software/grub/](http://www.gnu.org/software/grub/) for more information.

**Disk Partitioning**

**Storage Management**
Logical Volume Management (LVM) provides administrators with a range of facilities to manage storage. By default, the Fedora Core installation process formats drives as LVM volumes. Refer to [http://www.tldp.org/HOWTO/LVM-HOWTO/](http://www.tldp.org/HOWTO/LVM-HOWTO/) for more information.

**Audio Support**
The Linux kernel used by Fedora Core incorporates **ALSA** (Advanced Linux Sound Architecture). For more information about ALSA, refer to the project Web site: [http://www.alsa-project.org/](http://www.alsa-project.org/).

**Graphics System**
Both the installation system and Fedora Core use the **Xorg** suite to provide graphical capabilities. Components of **Xorg** manage the display, keyboard and mouse for the desktop environments that users interact with. Refer to [http://www.x.org/](http://www.x.org/) for more information.

**Remote Displays**
Fedora Core and *anaconda* include **VNC** (Virtual Network Computing) software to enable remote access to graphical displays. For more information about VNC, refer to the documentation on the RealVNC Web site: [http://www.realvnc.com/documentation/](http://www.realvnc.com/documentation/).

**Command-line Interface**
By default, Fedora Core uses the GNU **bash** shell to provide a command-line interface. The GNU Core Utilities complete the command-line environment. Refer to [http://www.gnu.org/software/bash/bash.html](http://www.gnu.org/software/bash/bash.html) for more information on **bash**. To learn more about the GNU Core Utilities, refer to [http://www.gnu.org/software/coreutils/](http://www.gnu.org/software/coreutils/).

**Remote System Access**
Fedora Core incorporates the **OpenSSH** suite to provide remote access to the system. The SSH
service enables a number of functions, which include access to the command-line from other systems, remote command execution, and network file transfers. During the installation process Anaconda may use the scp feature of OpenSSH to transfer crash reports to remote systems. Refer to the OpenSSH Web site for more information: http://www.openssh.com/.

Access Control
SELinux provides Mandatory Access Control (MAC) capabilities that supplement the standard Linux security features. Refer to the SELinux FAQ for more information: http://fedora.redhat.com/docs/selinux-faq/.

Firewall
The Linux kernel used by Fedora Core incorporates the netfilter framework to provide firewall features. The Netfilter project website provides documentation for both netfilter, and the iptables administration facilities: http://netfilter.org/documentation/index.html.

Software Installation
Fedora Core uses yum to manage the RPM packages that make up the system. Refer to http://fedora.redhat.com/docs/yum/ for more information.

Virtualization
Xen provides the capability to simultaneously run multiple operating systems on the same computer. Fedora Core also includes tools to install and manage the secondary systems on a Fedora Core host. You may select Xen support during the installation process, or at any time thereafter. Refer to http://www.fedoraproject.org/wiki/Tools/Xen for more information.
Index

A
ALSA (Advanced Linux Sound Architecture), 85
Anaconda, 85

B
BIOS (Basic Input/Output System), 11
boot loader, 30
(see also GRUB)
upgrading, 30

D
DHCP (Dynamic Host Configuration Protocol), 5, 45, 45
Disk Druid, 34
DNS (Domain Name Service), 46
domain name, 46
driver disks, 81

E
ext2 (see file systems)
ext3 (see file system) (see file systems)

F
feedback
contact information for this manual, ix
file system, 34	ext3, 34
NTFS , 36
vfat, 36
file systems
ext2, 20
text3, 20
vfat, 20
firewall
configuring, 62
documentation, 86
FOSS (free and open source software), 1
free software (see FOSS)

G
gateway, 46
GMT (Greenwich Mean Time) (see UTC)
GRUB
configuring, 39
(see also boot loader)
documentation, 85

H
hostname, 46

I
IP address, 45

K
Kickstart, 79

L
LVM, 35, 37
documentation, 85
logical volume, 34
physical volume, 34
understanding, 34
volume group, 34

M
master boot record, 39, 42
memory testing mode, 83
modem, 46
mount point, 33

N
NFS (Network File System)
install from, 21
NTFS (see file system)
NTP (Network Time Protocol), 47, 65

O
open source (see FOSS)
OpenSSH, 85
(see also SSH)
OSI (Open Source Initiative), 61

P
package groups, 54
partition
/home, 37
/root, 33
adding, 35
deleting, 37
editing, 36
illegal, 35
root, 33, 33, 35
type, 34
(see also file system)
PXE (Pre-boot eXecution Environment), 11, 15
Index

R
RAID, 37
    hardware, 31
    Linux software, 34
rescue discs, 83
rescue mode, 83
root account, 49
router (see gateway)

S
scp, 86
    (see also SSH)
SELinux
    configuring, 64
    documentation, 86
serial console, 76
Setup Agent, 61
Software Updater, 71
SSH (Secure SHell)
    documentation, 86
    firewall configuration, 62
swap partitions, 33
syslog, 78

T
Telnet, 78
text interface, 76

U
UTC (Universal Co-ordinated time), 47

V
vfat (see file system) (see file systems)
VNC (Virtual Network Computing), 77
    documentation, 85
    enabling, 77
    installing client, 77
    listening mode, 78

X
Xen
    documentation, 86
Xorg, 85

Y
yum, 71
    documentation, 86